Roope Paasikivi

OHJELMOITAVIEN LOGIIKOIDEN VARMUUSKOPIOINTI

Sahko- ja automaatiotekniikan koulutusohjelma
2018

@
samk O’

Satakunnan ammattikorkeakoulu
Satakunta University of Applied Sciences



OHJELMOITAVIEN LOGIIKOIDEN VARMUUSKOPIOINTI

Paasikivi, Roope

Satakunnan ammattikorkeakoulu

Sahko- ja automaatiotekniikan koulutusohjelma
Helmikuu 2018

Ohjaaja: Suvela, Timo

Sivuméara: 26

Liitteita: 12

Asiasanat: automaatio, ohjelmoitava logiikka, varmuuskopio

Tama  opinnaytetyd  tehtiin UPM Rauman  tehtaan  s&hko-  ja
automaatiokunnossapitoon liittyen. Tyon aiheena oli kartoittaa UPM Rauman tehtaan
ohjelmoitavat logiikat, sekd luoda ohjeet varmuuskopioinnista ja niiden
palauttamisesta jokaiselle tehtaalta 16ytyvélle logiikkaohjainten tuoteperheelle.
Taman lisdksi tyon tarkoituksena oli l0ytdd ratkaisu varmuuskopioiden
séilyttamiseen sek& lisatd varmuuskopioiden ottaminen ennakkokunnossapidon
piiriin.

Tyossa kasitelladn sitd, miten kartoitus tehtiin ja mitd ongelmia eri ohjelmoitavien
logiikoiden kartoituksessa ilmeni. Taman lisdksi tyossd esitelladdan UPM Rauman
tehtaan eri logiikkaohjainten tuoteperheitd seka niiden ohjelmointiymparistdja.
Lopuksi tyossa kasitelladn sita, miten kéytdnnon toteutus tehtiin varmuuskopioiden
ottamisen, palauttamisen, sailytyksen sekéd SAP-jarjestelman osalta.
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The purpose of this thesis was to survey programmable logic controllers in UPM
Rauma factory area and make device specific instructions for downloading and up-
loading from or to programmable logic controllers found in UPM Rauma factory ar-
ea. Also, the purpose of this thesis was to find solution for storing taken backups and
add programmable logic controllers backuping to SAP system for preventive mainte-
nance.

The thesis deals with how the survey was made and what problems there was with
different programmable logic controllers. Also the thesis introduces different pro-
grammable logic controllers and their programmable environments. At the end thesis
deals with how practical execution was made for backuping, storing and SAP sys-
tem.
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1 JOHDANTO

Taman opinndytetyon tarkoituksena on Kkartoittaa UPM Rauman tehtaan
ohjelmoitavat logiikat ja luoda selke&t laitekohtaiset ohjeet ohjelmoitavien
logiikoiden varmuuskopioinnista ja varmuuskopioiden palauttamisesta. Té&man
lisaksi tarkoituksena on kehittda ratkaisu siihen, miten varmuuskopioita sdilytetaan
siten, ettd sailytys on mahdollisimman helppokéyttdinen ja turvallinen.
Tarkoituksena on myos lisaté logiikoiden varmuuskopiointi ennakkokunnossapidon
piiriin. Kyseiset asiat tehddén, jotta koko tehtaalle saadaan luotua yhtendiset
kaytannot logiikoiden varmuuskopioinneista ja niiden sailytyksestd. Aikaisemmin
ongelmana on ollut se, ettd logiikoiden varmuuskopioinneista ei ole ollut mitaan

linjausta ja tasta syysta toimintatapoja on ollut useita erilaisia.

Tyossa apuna kaytetddn tehtaan omaa henkildokuntaa, lahinna sédhkdasentajia, jotka
tyoskentelevét paivittdin tehtaan ohjelmoitavien logiikoiden parissa. Heita kdytetaan
apuna ohjelmoitavien logiikoiden kartoituksessa, sek& haastatellaan siitd miten
logiikoiden séilytys ja varmuuskopiointi tulisi tehdd, koska loppujen lopuksi se

vaikuttaa eniten heidan tydskentelyynsa.



2 UPM - THE BIOFORE COMPANY

2.1 Yritysesittely

UPM-Kymmene Oyj on suomalainen metséteollisuusyhtid. Yhtio sai alkunsa 1996,
kun Repolan tytaryhtio Yhtyneet Paperitehtaat ja Kymmene fuusioituivat. Samalla
yhtioén fuusioitui myds Finnpap eli Suomen Paperitehtaiden Yhdistys. Nykyaan
UPM on yksi maailman suurimpia ja arvostetuimpia metsateollisuuden yrityksia.
Yhtion litkevaihto oli vuonna 2016 noin 9,8 miljardia euroa ja osakkeenomistajia
yhtiolla oli vuoden 2016 lopussa noin 85 000. Yhtid tyollistdd 19 300 tyontekijaa ja

silla on tuotantoa 12 eri maassa. (UPM-Intranet www-sivut, 2017)

UPM muodostuu kuudesta eri liiketoiminta-alueesta, jotka ovat UPM Biorefining,
UPM Energy, UPM Raflatac, UPM Specialty Papers, Paper ENA seka UPM
Plywood. Naitd kaikkia liiketoiminta-alueita yhdistdd tuotteiden valmistus
vastuullisesti hankituista ja uusiutuvista raaka-aineista. UPM myaos pyrkii jatkuvasti
kehittdmadn uutta ja kestdvad liiketoimintaa, josta hyvéna esimerkkind toimivat
biopolttoaineet, biokomposiitit seka biokemikaalit. (UPM-Intranet www-sivut, 2017)

2.2 UPM Rauman tehdas

UPM Rauman tehdas tyéllistad suoraan talla hetkellda noin 520 tyontekijad, mutta sen
valillinen tydllistava vaikutus on jopa nelja kertaa enemmén. Rauman tehdasalue
kattaa kolme paperikonetta, pakkaamon, biovoimalaitoksen, jate- ja vesilaitoksen,
kuorimoalueen seka fluff-sellu eli pehmopaperitehtaan. Paperikoneilla valmistetaan
paallystettya ja paallystamatonta aikakausilehtipaperia. Paperikone 1 ja paperikone 4
valmistavat paallystettya LWC-aikakauslehtipaperia ja paperikone 2 valmistaa
paallystamatonta  SC-aikakauslehtipaperia. Paperikoneiden yhteenlaskettu
tuotantokyky on noin 960 000 tonnia vuodessa. RaumaCell valmistaa fluff-sellua,
jota  k&ytetddn muun muassa  kuivapaperin  jatkojalostuksessa, naisten
hygieniatuotteissa ja vaipoissa. Sen tuotantokapasiteetti on 150 000 tonnia vuodessa.
Aikaisemmin UPM Rauman tehtaalla oli myds paperikone 3, mutta se suljettiin
huhtikuussa 2013. (UPM-Intranet www-sivut, 2017)
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Kuva 1. UPM Rauman tehdasalue (UPM-Intranet, 2017)

3 UPM RAUMAN TEHTAALLA KAYTETTAVAT LOGIIKAT

3.1 SIMATIC S5

SIMATIC S5 -tuoteperhe julkaistiin vuonna 1979. Vaikka se on nykyaan
aktiivituotannosta poistunut tuoteperhe, niin S5-tuoteperheen laitteita on yha laajasti
kaytossa teollisuudessa. S5-tuoteperheeseen kuuluu 90U, 95U, 101U ,100U, 105,
110, 115, 115U, 135U, 150S sek& 155U ja niitd ohjelmoidaan STEP 5 -ohjelman
avulla.  (Siemens:n  wwwe-sivut, 2017) Kuten  monessa  muussakin
teollisuuslaitoksessa, niin UPM Rauman tehtaaltakin [0ytyy vield useita eri
SIMATIC S5 -tuoteperheen logiikoita.

SIMATIC S5 -tuoteperhe on ongelmallinen kartoituksen suhteen. Ongelmalliseksi
sen kartoituksen tekee se, ettd STEP 5 -ohjelmassa ei kaytdssé olevaa laitteistoa

tarvitse madritellda ohjelmaan, toisin kuin uudemmassa SIMATIC S7 -tuoteperheen



kayttdmassa STEP 7 -ohjelmassa tai TIA Portal
-ohjelmassa. Ongelmia S5-tuoteperheen kartoituksessa tuottavat myods input- ja
output-korttien MLFB-tunnukset. Korttien tunnukset sijaitsevat korttien sivussa,
joten rakin ollessa tdynna, ei korttien tunnusta péase ndkemaan poistamatta korttia.
Useissa suuremmissa kokonaisuuksissa on myds paljon hajautettua 1/0O:ta kentalla.
Ne lisdavat kartoitettavaa huomattavan paljon ja lisaksi ne ovat usein kentélla

mahdollisesti vaikeissakin paikoissa.

3.2 SIMATIC S7-200

S7-200-sarja on nykyisen S7-1200-sarjan edeltdjd. Sen logiikkaohjaimet ovat
luotettavia, nopeita ja joustavia mikroprosessoriohjaimia. Sen CPU yhdistaa
mikroprosessorin, integroidun virtaldhteen sekd inputit ja outputit kompaktiksi
paketiksi. S7-200-ohjainten ohjelmointiin kaytetddn omaa STEP 7 Micro/WIN -
ohjelmistoa. (Siemens www-sivut; SIMATIC S7-200 Programmable Controller
System Manual) Rauman tehtaalla S7-200-sarjan logiikkaohjaimia kéytetadn
esimerkiksi konevalpissé seka tuhkal&hettimissa.

SIEMENS

QNN 30%0

Kuva 3. Esimerkki S7-200-sarjan CPU:sta (Paasikivi, 2017)



3.3 SIMATIC S7-300

S7-300-sarjan ohjelmoitavat logiikat ovat yksi Siemensin tunnetuimmista tuotteista.
Sarjan logiikkaohjainten kayttokohteet ovat todella monipuoliset, silla ne ulottuvat
erilaisista prosessi- ja kappaletavarateollisuuden ohjauksista aina yksittéisten

koneiden ohjauksiin.

Sarja tukee sek& Profibus- ettd Profinet-kenttdvaylid. Siitd on myo6s saatavilla
turvateknisia ~F-CPU-malleja, jotka téyttdvat viranomaisten  vaatimukset
koneturvallisuuden sovelluksissa, sekda T-CPU-malleja, jotka on tarkoitettu
lilkkeenohjaussovelluksiin, koska ne siséltavat teknologiafunktioita. Sarjalla on
modulaarinen rakenne eli I/0-moduuleja ja kommunikointimoduuleja voidaan lisata
tarpeen mukaan. Sarjan logiikoihin on saatavilla myés MMC-Kkortti, joka on flash-
muisti, eli se ei tarvitse paristovarmennusta. Sarjan monista malleista 16ytyy myos
haastaviin olosuhteisiin soveltuvat SIPLUS-versio ja tdmén lisaksi, se on erittdin
monipuolisesti laajennettavissa hajautetun 1/0:n komponenteilla. Sarjan tuotteet
my6s kommunikoivat saumattomasti S7-400-logiikkaohjainten kanssa. (Siemens

www-sivut, 2017)

Kuva 4. Esimerkkeja SIMATIC S7-300-sarjan malleista (Siemens www-sivut, 2017)
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3.4 SIMATIC S7-400

S7-400-sarjan logiikkaohjaimet ovat Siemensin tehokkaimpia ohjaimia. Niiden
monipuoliset kommunikointikyvyt ja suuri maéra integroituja kommunikointiportteja
tekevat niista erityisen sopivia vaativien prosessi- ja koneohjausten paalogiikoiksi.
S7-400-sarjan ohjaimet voidaan jakaa tavallisiin, koneturvallisuuden vaatimukset
tayttaviin seka kahdennettuihin ohjaimiin. Kahdennettuja ohjaimia voidaan kuitenkin
kayttad myoOs turvaohjausten toteuttamiseen. Ohjaimilla voidaan siis toteuttaa
turvaohjauksia seka kone-, ettd prosessiturvallisuuden tarpeisiin. S7-400-ohjaimissa
voidaan kayttaa paikallista S7-400 10:ta tai etd-10:ta. Eta-10:t toteutetaan ET200-

tuotteiden avulla. (Siemens www-sivut, 2017)

Tavallisten S7-400-ohjainten liséksi UPM Rauman tehtaalta 16ytyy myds S7-400H-
ohjaimia. Niitd voidaan kéyttdd yksittdisend turvalogiikkana tai kahdennettuna
prosessiasemana ja kahdennettua prosessiasemaa voidaan kayttdd myos

kahdennettuna turvaprosessiasemana.

S7-400-sarjan logiikoiden ohjelmointi tapahtuu joko Step 7- tai TIA Portal
-ympéristossd. TIA Portal-ymparistod voidaan kuitenkin kayttda vain tiettyjen
uudempien S7-400-sarjan logiikoiden ohjelmoinnissa. UPM Rauman tehtaalla
kaytetdan vielda pelkédstddn Step 7 -ympéristdd S7-400-sarjan logiikoiden
ohjelmoinnissa jo siitdkin syystd, ettda alkuperdiset ohjelmat on tehty kyseisella
ohjelmointiympéristolla. Taméan liséksi esimerkiksi H-CPU:t eivét ole talla hetkelld
tuettuna TIA Portal -ymparistdssa. (Siemens www-sivut, 2017)

Kuva 5. Esimerkki SIMATIC S7-400-sarjan CPU:sta (Siemens www-sivut, 2017)
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3.5 SIMATIC S7-1500

Vuonna 2013 ilmestynyt S7-1500-sarja on Siemensin edistyksellisin tuoteperhe. S7-
1500-logiikkaohjaimet siséltdvat monia asioita, joihin on aikaisemmin tarvittu joko
erillisia ohjelmistoja tai lisdlaitteita. Sarjan ohjaimilla voidaan toteuttaa ratkaisuja,

joihin on aiemmin kaytetty S7-300- tai S7-400-logiikkaohjaimia.

Logiikkaohjaimiin  integroitujen  toimintojen  avulla  voidaan tavallisten
automaatiosovellusten lisaksi toteuttaa esimerkiksi S&ato- ja
liikkeenohjaussovelluksia helposti. S7-1500-sarja sisaltdd myds SIL3-tasolle asti
hyvéksyttyja turvalogiikkaohjaimia. S7-1500-sarjan kanssa kaytetd&dn TIA Portal -
ohjelmointialustaa. (Siemens www-sivut, 2017) Talla hetkelld UPM Rauman
tehtaalla on vain pari S7-1500 kompakti-CPU:ta, mutta tulevaisuudessa S7-1500-

sarjan logiikoiden maara tulee varmasti lisdantymaan.
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Kuva 6. SIMATIC S7-1500 kompakti-CPU:t (Siemens www-sivut, 2017)

3.6 Logo!

Logo! on Siemensin pienin ohjelmoitava logiikka. Se on helppokéyttinen ja siséltada
paljon valmiiksi ohjelmoituja toimintoja. Sen tyypillinen kayttokohde on
taloautomaation perustoiminnat, kuten valaistusratkaisut ja lammonsaadét. Logo!:lla
saadaan myo6s kustannussaastojd, koska séhkdsuunnittelu helpottuu ja releita
tarvitaan vahemman. Logo!:n ohjelmoinnissa kaytetddn Logo! Soft Comfort -
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ohjelmaa. (Siemens www-sivut, 2017) Rauman tehtaalla Logo!-sarjan ohjelmoitavia
logiikoita kéaytetaan esimerkiksi hylsysahan polynpoistossa sekd konevalpissa.

SIEMENS LOGO!

LAN

MAL AUDHESS EU-DL-AQ-UU-(L-BA
OUTPUT 4xRELAY/10A
rra—— .

L
a1

Kuva 7. Esimerkki LOGO!-sarjan CPU:sta (Siemens www-sivut, 2017)

3.7 Hajautettu I/0 (ET 200)

Nykyiset automaatiototeutukset siséltavét lahes aina 1ahto- ja tulopiirejd, jotka on
sijoitettu prosessiaseman luota ldhemmaés toimilaitteita ja antureita. Talldista
toteutusta sanotaan hajautetuksi 1/0:ksi. Sen suurin hyéty on huomattava
kaapeloinnin véhentyminen verrattuna siihen, ettd kaikki 1ahdét ja tulot tuotaisiin
prosessiasemalle asti erikseen. Siemensin ratkaisu hajautettuun 1/0:hon on SIMATIC
ET 200 -tuotesarja. Sarjasta l0ytyy logiikkaohjaimen sisaltavia, turvatekniikkaa
tukevia seka kosteudelta suojattuja malleja ja ne tukevat Profibus ja Profinet -
kenttavaylia. Kaikki sarjan hajautusasemat myods konfiguroidaan samalla tydkalulla,
jolla logiikkaohjaimet ohjelmoidaan. (Siemens wwwe-sivut, 2017) UPM Rauman
tehtaalta ET-200-sarjan tuotteista 16ytyy ET 200S ja ET 200M.
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KUVA 8. ET 200-sarjan tuotteita (Siemens www-sivut, 2017)

4 KARTOITTAMINEN

4.1 UPM Rauman teollisuusalueen kartoitus

Opinnaytetyon tekeminen aloitettiin kartoittamalla UPM Rauman tehtaan logiikat.
Kartoituksen avulla saatiin hyva kuva Rauman tehtaan logiikoista ja niiden maarasta.
Kartoituksesta oli myos hyo6tyé laitekohtaisten varmuuskopiointiohjeiden luomisessa,
koska sen avulla saatiin tarkka kasitys kaytdssa olevista logiikkaohjainten

tuoteperheista.

Pohjana kartoitukselle toimi 2010 tehty Excel-taulukko. Vanhassa Excel-taulukossa
oli kuitenkin paljon virheitd, koska se oli tehty kdymatta paikan paalla tarkistamassa
ohjelmoitavien  logiikoiden  komponentteja.  Kartoituksessa oli  kaytetty
suunnittelukuvia sekd SAP-jérjestelmén tietoja. Taman lisdksi moneen eri kohteeseen
oli vanhan kartoituksen jalkeen paivitetty uudempaa logiikkaa tai vaihdettu logiikan
komponentteja. Jatkossa uutta kartoitusta voidaan hyddynt&é esimerkiksi, kun jokin
logiikka hajoaa. Té&ll6in siitd voidaan nopeasti 16yté4 tilalle korvaava komponentti

vahemman tarkedasta laitteesta.
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Uusi kartoitus tehtiin Excel-taulukkoon, johon taulukoitiin osasto, laite, raamitunnus,
kaappitunnus, laitetyyppi, UPM-nimike, MLFB (Machine-Readable Product
Designation) sekd kuvaus. Kartoitettava alue oli laaja, ja Kkartoituksesta tulikin
yhteensd noin 3300 rivid pitkd. Kartoitusta ei kuitenkaan voida julkaista tyon

liitteend, koska se on salassa pidettdvad materiaalia.

1 |Osasto Laite Raamitunnus kaappitunnus. |Isitetyyppi |UPM-nimks WLFE Kuvaus
175|PAPERIKONE 4 URK$2Z A10 =+43-LKB01A2 PLC 18207777 GEST40DITADI0AAD  SIMATIC 57-400, URL RACK, CENTRALIZED AND DISTRIBUTEC
176|PAPERIKONE4  URK42 A10 =+43-LKBD1A2 pLC 18197421 6EST4070RADD0AAD  SIMATIC S7-400, PS 407 POWER SUPPLY, 204, 120/230V AC
177|PAPERIKONE4  URK42 A10 =+43-LKB01A2 57-400 6ES74162XKD20AB0  SIMATIC §7-400, CPU 416-2 1.6 MB WORKING MEMORY (0.
178|PAPERIKONE4  URK4Z A10 =+43-LKB01A2 MEMORY 034055  GES79521AL0DCAAC  SIMATIC 57, RAM MEMORY CARD FOR 57-400, LONG VERSIC
173|PAPERIKONE4  URK$2 A10 =+43-LKB01A2 BATTERY 047402  GES79710BA00 SIMATIC 57-400, BACK-UP BATTERY 3.6 /2.3 AH FOR PS 40t
180|PAPERIKONE4  URK42 A10 =+43-LKBD1A2 pLC 6GK74435DXODOXED  SIMATIC NET, CP 443-5 COMMUNICATIONS PROCESSOR FOI
181|PAPERIKONE4  URK42 A10 =+43-LKB01A2 PLC 6ES74700AADC0AMD  SIMATIC 57-400, ADAPTER MODULE —~CANNOT BE ORDERED
182|PAPERIKONE4  URK4Z Al0 =+43-LKB01A2 PLC 6ES74700AADCOAAC  SIMATIC 57-400, ADAPTER MODULE —~CANNOT BE ORDERED
183|PAPERIKONE4  URK4Z Al0 =+43-LKB01A2 PLC 000653  GESS2421AA41 SIMATIC S5 P 242B HIGH SPEED COUNTER MOD. 7 CHANNE
184|PAPERIKONE4  URK42 A10 =+43-LKBD1A2 pLC 000653  6ESS2421AAd1 SIMATIC S5 P 242B HIGH SPEED COUNTER MOD. 7 CHANNE
185|PAPERIKONE4  URK42 A10 =+43-LKB01A2 PLC 6ES74412AAD30AED  SIMATIC 57-400, CP 441-2 COMMUNICATIONS MODULE FO
186|PAPERIKONE4  URK42 Al0 =+43-LKB01A2 PLC 6GK74431EX100XED  SIMATIC NET, CP 443-1 COMMUNICATIONS PROCESSOR FOI

Kuva 2. Esimerkki kartoitustaulukosta (Paasikivi, 2017)

4.2 Kartoitus menetelmat

Kartoitus tehtiin niin, ettd SIMATIC S5 -sarjan logiikat kaytiin kuvaamassa paikan
paalla ja tdman jalkeen ne dokumentoitiin Excel-taulukkoon komponentti
komponentilta. Uudemmat SIMATIC S7 -sarjan logiikat olivat kartoituksen suhteen
helpompia, koska niiden toiminta vaatii kaytdssa olevien laitteiden konfiguroinnin
SIMATIC STEP 7- tai TIA Portal -ohjelmistoon. Néin ollen kyseisten logiikoiden
komponentit saatiin otettua suoraan ohjelmointilaitteilta. Ohjelmasta ei kuitenkaan
saa suoraan otettua komponenttiluetteloa Exceliin, vaan ne jouduttiin taulukoimaan
kasin haluttuun muotoon. Kyseinen tapa oli kuitenkin huomattavasti nopeampi kuin
SIMATIC S5 -sarjan logiikoiden kartoitus, koska tassé tapauksessa myods kentalla
olevat hajautetut 1/O:t saatiin suoraan STEP 7- tai TIA Portal -ohjelmistosta.
Kuitenkin myds uudemmat S7-sarjan ohjelmoitavat logiikat kaytiin tarkistamassa
paikan pééalla, koska laitteiden konfiguroinnista ei nde kéytdssa olevaa muistikorttia.

Samalla saatiin my6s kaappitunnukset, joissa logiikat sijaitsevat.
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5 OHJELMOINTIYMPARISTOT

5.1 STEPS

STEP 5 on PC-pohjainen ohjelmointity0kalu, jonka avulla voidaan ohjelmoida,
testata ja kayttdonottaa Siemensin S5-sarjan logiikoita. Alkuperdinen versio toimi
CP/M -kéyttojarjestelmalla. Vuonna 1996 julkaistiin versio 6.5, joka oli
ensimmainen MS-DOS-kayttojarjestelméssa toimiva versio. Myods uudemmat versiot
pohjautuvat MS-DOS-ké&yttojarjestelmaan. Viimeisin versio 7.23 julkaistiin vuonna
2004 ja se mahdollisti STEP 5 -ohjelmointity6kalun kayton Windows XP SP3:lla.
Taman jalkeen Siemens alkoi vahitellen luopumaan S5-sarjan kehityksesta ja siirsi

voimavaransa S7-sarjan kehitykseen.
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Kuva 10. STEP 5 -ohjelmointindkymé (Paasikivi, 2017)

S5-sarjan  ohjelmoitavia logiikoita on kuitenkin edelleen paljon kaytossa
teollisuudessa ja sen myotd myds STEP 5 on edelleen yleisesti kaytossd. Kéayttd
kuitenkin vahenee jatkuvasti, koska teollisuudessa siirrytddn S7-sarjaan laitteiden
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uusimisen myo6tad. Taman lisdksi STEP 5 -osaajien maadra véhenee jatkuvasti, koska
moni nykypéaivén tietokoneiden kayttajista ei valttdmattd ole koskaan edes nahnyt tai
kayttdnyt MS-DOS-kayttojarjestelméd, johon STEP 5 nykyaankin pohjautuu. Taman
lisaksi siirtyminen S5-sarjasta S7-sarjaan on pyritty tekemadn mahdollisimman
helpoksi. STEP 7 siséltda ohjelman, joka kaantad STEP 5:114 tehdyt ohjelmat STEP 7
-muotoon. (Support industry Siemens www-sivut; Industrial Savvy www-sivut,
2017)

52 STEP7

S7-sarjan ohjelmoitavien logiikoiden ohjelmointiin tarkoitettu STEP 7 ilmestyi
vuonna 1995. S7-sarja on Siemensin yleisimmin kaytetty laiteperhe teollisuudessa ja
sen myo6td STEP 7 on laajasti kéytetty ohjelmointiohjelma. STEP 7 -ohjelma tayttaa
IEC 61131-3 -standardin vaatimukset. STEP 7 -ohjelmaa kédytetdan S7-300-, S7-400-
ja SIMATIC WinAC -ohjainten ohjelmointiin. (Induteq www-sivut, 2017)

A |

Kuva 11. STEP 7 -ohjelman pikakuvake (Paasikivi, 2017)
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Kuva 12. STEP 7-ohjelma (Paasikivi, 2017)

STEP 7:n ulkoasu ja kaytettdvyys eroavat huomattavasti edeltdjastaan STEP 5:sté.
Suurin syy tdhan on siirtyminen MS-DOS-kayttojarjestelmasta  Windows-
kayttojarjestelmaan. Suurin muutos edeltdjadnsd verrattuna oli hiiren kdyttdmisen
yleistyminen. STEP 5 oli suunniteltu kaytettdvéaksi ilman hiirt4, kun taas STEP 7
vaatii hiiren kayttdmistd. Toinen suuri muutos oli HW-konfiguraation tulo. STEP
5:ssa ei tarvinnut maaritella HW-konfiguraatiota eli kéaytossd olevaa laitteistoa.
Néiden muutosten lisdksi tuli eroja ohjelmistorakenteeseen, kuten uusia
lohkotyyppeja. (Support industry Siemens-www-sivut; Siemens.com-www-sivut,
2017)
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5.3 TIA Portal

Siemensin uusin ja kehittynein ohjelmointiohjelmisto, joka ilmestyi vuonna 2011. Se
on suunniteltu niin pienten kuin suurten logiikkaohjainten ohjelmointiin ja se kattaa
kaikki tarpeet yksittdisistd koneohjauksista laajoihin turvatoimintoja siséltéviin
kokonaisuuksiin. Se yhdistdd samaan pakettiin STEP 7 -logiikkaohjelmoinnin ja
WinCC-kayttoliittymasuunnittelun sek& uusimpana myds SINAMICS StartDrive —
taajuusmuuttajien parametroinnin. Silld voidaan ohjelmoida uudempien S7-1200- ja
S7-1500-sarjan logiikoiden lisaksi tiettyja vanhempia S7-sarjan logiikoita. TIA
Portal -ympdristostd ei myoskadn ainakaan viela l0ydy tukea CFC-
ohjelmointikielelle. Yhdistamalla aiemmin mainitut asiat ohjelmasta on saatu
kayttajaystavallisempi kokonaisuus ja talla tavoin vain yhden ohjelman osaaminen
riittaa. Se myos taytyy IEC 61131-3

-standardin vaatimukset. (Siemens www-sivut, 2017)

TIA Portal W12

Kuva 13. TIA Portal V12 -ohjelman pikakuvake (Paasikivi, 2017)

T T

v Languages & resources

Kuva 14. TIA Portal V12 -ohjelma (Paasikivi, 2017)

Ohjelmoinnin n&kdkulmasta TIA Portal ei eroa juurikaan STEP 7:sta. Tastd syysté
STEP 7 V5.4/55 -projektit voidaankin k&antdd TIA Portal -versiolle.
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Varmuuskopioinnin ja kunnossapidon ndkokulmasta yksi suuri muutos STEP 7 -
ohjelmistoon on se, ettd uudet TIA Portal -tuetut S7-1200- ja S7-1500-logiikat
tallentavat kommentit ja symbolit PLC:lle. Tastd syystd koko projekti kyetdan
lataamaan PLC:Itd kommentteineen ja symboleineen, vaikka alkuperéista projektia ei
olisi olemassa. Tamé ei kuitenkaan varsinaisesti ole TIA Portalin ominaisuus vaan
kyseisten logiikoiden ominaisuus. (Siemens www-sivut; Support industry Siemens-

www-sivut, 2017)

5.4 SIMATIC STEP 7-Micro/WIN

Micro/WIN-ohjelmisto on tarkoitettu vain S7-200-sarjan logiikoiden ohjelmointiin.
Se on helppokéyttdinen ja siséltdd kaikki tarvittavat tyokalut IEC 1131 -

yhteensopivaan ohjelmointiin. Sen viimeisin versio 4.0 tukee Windowsin

kayttojarjestelmia aina Windows 7 -kéyttojarjestelméaan asti. (Siemens:n www-sivut,
2017)

Y4.05TEP 7
MicroIn SP3

EE K EAA aL

%

Reaty Pt Row 1, it e

Kuva 16. STEP 7-Micro/WIN -ohjelma (Paasikivi, 2017)
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5.5 IEC 61131

IEC 61131 on IEC-standardi ohjelmoitaville logiikoille. Sen on kehittanyt
International Electrotechnical Commission, joka on kansainvalinen s&hkdalan
standardointiorganisaatio. Se tunnettiin aiemmin nimella IEC 1131, mutta vaihtui
nykyiseen kun IEC:n numerointijarjestelm&d muutettiin. Se on jaettu kymmeneen
osaan, joista IEC 61131-3 on aiemmin mainittu liittyen ohjelmoitavien logiikoiden

ohjelmointiohjelmiin. (PLCopen www-sivut; IEC:n www-sivut, 2017)

6 KAYTANNON TOTEUTUS

6.1 Varmuuskopiointi

UPM Rauman tehtaalla ongelmana oli toisistaan eroavat kaytdnnét ohjelmoitavien
logiikoiden varmuuskopioimisessa ja varmuuskopioiden sailyttamisessa. Kyseisista
asioista ei koskaan ollut tehty selkedd linjausta ja tasta syysté tehtaan eri alueilla oli
suuria eroja varmuuskopioiden ottamisessa ja séilyttdmisessd. Osassa tehtaan alueista
ei varmuuskopioita otettu oikeastaan koskaan tai jos otettiin, niille ei valttamatta
ollut selkedéd sailytyspaikkaa, jonka esimerkiksi kaikki vuorossa tydskentelevat
séhkoasentajat tietdisivat. Naistd syistd oli tapahtunut esimerkiksi niin, ettd vanhan
logiikan hajottua uudelle logiikalle oltiin ladattu vanha varmuuskopio, joka sisélsi
vanhoja alkuarvoja. Tama taas aiheutti sen, ettd paperin laatu kérsi tai laitteiden

korjaamiseen ja uudelleenparametrointiin kului ylimaaraista aikaa.

Myos varmuuskopioiden ottamisen osaamisessa ilmeni ongelmia. Kyseisten syiden
takia oli tarkeda luoda selked linja varmuuskopioiden ottamisesta ja séilyttdmisestd,
sekd tehda selkeat laitekohtaiset ohjeet, miten kultakin eri logiikkatyypiltd otetaan
varmuuskopio ja miten varmuuskopio palautetaan logiikalle. Ohjeita tehtiin yhteensa
13 kappaletta. Jokaiselle ohjelmoitavalle logiikkasarjalle tehtiin oma ohjeensa, miten

kyseiseltd logiikalta otetaan varmuuskopio ja miten varmuuskopio palautetaan
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logiikalle, jos tarve sen vaatii. Luoduista ohjeista 12 kappaletta ovat liitteind tdssa
tyossa.

6.2 Ennakkohuoltosuunnitelmat

Yhtena osana ty6té oli saattaa logiikoiden varmuuskopiointi ennakkohuollon piiriin.
Aiemmin tehdyn logiikoiden kartoituksen avulla tehtiin Kriittisyysanalyysi laitteen
tarkeydesta paperin laadun ja tuotannon ndkokulmasta. Kriittisimpiin laitteisiin,
kuten pituusleikkurit, varmuuskopioiden ottovéliksi maarattiin kolme kuukautta ja
vahemman Kkriittisille laitteille valiksi méaérattiin yksi vuosi. Taman lisaksi tietysti
ohjeistettiin, ettd logiikalta otetaan varmuuskopio aina, kun logiikoihin tehdaén

ohjelmamuutoksia.

SAP-jarjestelméén luotiin ennakkohuoltosuunnitelmia, jotka sisaltavat tiedot milta
laitteelta varmuuskopio on tarkoitus ottaa ja taman lisdksi mukana on ohjeet
kyseiselle logiikkatyypille sek& yleinen ohje varmuuskopioiden ottamisesta. Kun ty0
on tehty, se kuitataan tehdyksi SAP-jarjestelmaan ja seuraavan kerran tyd tulee
ennakkohuoltoon tehtavéksi kyseiselle laitteelle maaritellyn ajan jalkeen. Kuvassa 17
nahdaan esimerkki SAP-ohjelman tyostd, jossa ohjelmoitavana logiikkana on
SIMATIC S7-300- tai S7-400-sarjan logiikka.
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Kuva 17. Esimerkki SAP-ohjelman ennakkohuoltotydsta (SAP-ohjelmisto)

6.3 Varmuuskopioiden sailytys

Varmuuskopioiden séilytykseen haluttiin yhtendinen linja, niin ettd varmuuskopiot
olisivat helposti péivitettvissa ja saatavilla sekd niiden sijainti olisi kaikille tiedossa.
Aluksi tutkittiin mahdollisuutta, ettd ne laitettaisiin UPM Rauman tehtaan siséiseen
verkkoon. Tultiin kuitenkin siihen tulokseen, ettd siitd tulisi helposti liian

monimutkaista, jo siitédkin syysta, ettd monet ohjelmointilaitteet eivat ole lainkaan
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verkossa, eika niitd myoskaan haluta laittaa verkkoon, jo pelkastaan tietoturvasyista.
Naista syistd paadyttiin ratkaisuun, ettd varmuuskopioiden séilyttamiseen kaytetaan
USB-muistitikkuja ja niille tehd&an kolmelle eri alueelle pelkastéan niille tarkoitettu

séilytyspaikka.

USB-tikkujen tietoturvan takaamiseksi ohjeisiin siséllytettiin, miten USB-
muistitikkuja séilytetddn ja ettd niitd ei myoskaan saa missddn nimessa kayttaa
muissa kuin ohjelmointilaitteissa. Ohjeissa my06s painotettiin oikeaa tapaa ottaa
muistitikku pois koneesta, jotta se ei vahingossakaan korruptoidu, eli aina kaytetaan

Windowsin omaa ohjelmaa tietovélineen poistamiseksi turvallisesti laitteesta.

Aikaisemmin kaikkia alueen varmuuskopioita oli saatettu sailyttdd vain yhdella
USB-muistitikulla. Téssd on se vaara, ettd muistitikun mennessa hukkaan tai
korruptoituessa katoavat kaikki varmuuskopiot. Toki myds samat varmuuskopiot
ovat ohjelmointilaitteilla, joista ne on siirretty muistitikulle. Nyt jokaiselle laitteelle
tai laitteille maarattiin oma muistitikku, jossa on Kkiinni avaimenperd, missa lukee
mille laitteelle tai laitteille se on tarkoitettu. Tamén liséksi avaimenperalliset USB-
muistitikut jaettiin niin, ettd jokaisella alueella on oma vérityksensd, josta tietda
helposti mille tehtaan alueelle kyseinen USB-muistitikku on tarkoitettu. Taman
lisaksi jokaisen muistitikun ensimmainen kansio nimettiin sen laitteen mukaan, jolle
kyseinen muistitikku on tarkoitettu. Nain saatiin minimoitua mahdollisuus, ett4
avaimenpera jostain syystd katoaa, eikd tdmén jalkeen ole tayttd varmuutta, mille
laitteelle muistitikku on tarkoitettu. USB-muistitikuille luotiin myds valmiiksi omat
kansionsa AG-kopioille seka tyblevyn kopiolle, jotta ndma eivat vahingossakaan

mene sekaisin.

USB-muistitikkujen sailytysta varten tilattiin kolme avainkaappia, jotka sijoitettiin
kolmen eri alueen sahkd- ja automaatioverstaille. Avainkaappeihin tehtiin
sisallysluettelo, sinne kuuluvista muistitikuista ja se nimettiin selkeésti vain
varmuuskopioiden sdilytyksen kayttoon. Kuvissa 18 ja 19 on esimerkki paperikone

4:lle sijoitetusta avainkaapista, jossa varmuuskopioita sailytetaan.
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Kuva 18. Paperikone 4 alueen logiikoiden varmuuskopioiden séilytyskaappi
(Paasikivi, 2017)



Kuva 19. Paperikone 4:n alueen varmuuskopioiden séilytyskaappi sisélta (Paasikivi,
2017)
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7 YHTEENVETO

Taman opinndytetyon tavoitteena oli kartoittaa UPM Rauman tehtaan alueen kaikki
ohjelmoitavat logiikat, luoda laitekohtaiset ohjeet logiikoiden varmuuskopioimisesta,
sekd  varmuuskopioiden  palauttamisesta  logiikoille ja luoda ratkaisu
varmuuskopioiden sdilytykseen. Taman liséksi tarkoituksena oli lisatd logiikoiden
varmuuskopiointi ennakkohuollon piiriin. Kaikki tavoitteet saavutettiin tekemélla
yhteisty6té tehtaan oman séhko- ja automaatiokunnossapidon asentajien kanssa seka

UPM Rauman SAP-jarjestelmaa hallinnoivien henkildiden kanssa.

Opinnaytety6té tehdessani opin runsaasti uusia asioita ohjelmoitavista logiikoista ja
niiden ohjelmointiymparistoista. Vaikka paaaiheena oli ohjelmoitavien logiikoiden
varmuuskopiointi ja varmuuskopioiden palauttaminen, niin opin kuitenkin myds
paljon muuta ohjelmoitaviin logiikkoihin liittyvad, kuten erilaisten muistien
ominaisuudet ohjelmoitavissa logiikoissa. Kartoitusta tehdessd myds tutustuin
erittdin moniin ojelmoitaviin logiikoihin liitettaviin moduuleihin ja siithen mihin niita
kaytetdan. Opin myds paljon uutta vanhemmista SIMATIC S5 -sarjan logiikoista ja
STEP 5 -ohjelmointiympadristostd, koska en ollut koskaan aiemmin kayttanyt
kyseistd ohjelmoitavaa logiikkasarjaa tai sen ohjelmointiymparistéd. Tyon ehk&
suurin haaste oli l16ytdd hyva tapa kartoituksen tekemiseen mahdollisimman
tehokkaasti, koska aika tehtaalla oli rajallinen. Oman oppimiseni lisdksi sain
mielestdni tehtaalla hyvda keskustelua aikaan asentajien kanssa, liittyen

ohjelmoitavien logiikoiden varmuuskopioimiseen ja ominaisuuksiin.
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LITE 1 sivu1()

Yleiset ohjeet logiikoiden varmuuskopioinnista

lokaiselle laitteelle tai laiteille on oma nimetty muistitikku, Muistitikkuja sailytetdan vain niille varatussa kaapissa

ja niita ei kaytetd mihinkdan muuhun kuin kyseisen laitteen/laitteiden varmuuskopioiden sailyttamiseen, eika niita
liitetd muihin kuin ohjelmointilaitteisiin. Tarked3d on myos poistaa muistitikku aina oikealla tavalla eli kayttaa Safely
Remove Hardware and Eject Media —toimintoal

Muistitikulle otetaan sekd AG-kopio, ettd kopio tydlevystd. AG-kopio ei sisdllda kommentteja eikd symboleita (Pois
lukien 57-1500, jossa CPU sisaltaa myos kommentit ja symbolit), joten on erittdin tarkeaa, ettd myas tyolevysta on
kopio muistitikulla ja ettd se tasmaa AG-kopion kanssa. AG-kopiota otettaessa se kannattaa ensin tallentaa
PG/PC:lle ja tdman jalkeen kopioida sieltd kyseisen laitteen muistitikulle. Ohjelmamuutokset tehd&in pelkistidn
tydlevylle, ei koskaan AG-kopioclle.

Muistitikulle otetaan varmuuskopio aina, kun kyseiseen logiikkaan tehd&in muutoksia. Logiikoiden
varmuuskopioinnista tulee myos maaraajoin ennakkokunnossapidollinen tyd SAP:iin varmuuskopion ottamisesta
kultakin laitteelta.

Koska jokaiselle laitteelle/laitteille on oma muistitikku, niin varmuuskopion nimeen ei tarvitse sisallyttaa laitetta,
koska se ei valttamatta onnistu esimerkiksi $5-logiikoiden kanssa johtuen nimen maksimipituudesta. Nimeaminen
tehd&dn aina samalla kaavalla, joka on esitetty seuraavaksi: AG-kopio nimetdin esimerkiksi AG4117, jossa AG
tarkoittaa AG-kopiota, 41 tarkoittaa meneillddn olevaa viikkoa ja 17 tarkeittaa vuotta. Jos tiedetaan, ettd AG-
kopioita otetaan useampi saman viikon aikana ja kaikki kopiot halutaan sailyttad, niin AG-kopio voidaan nimetd
paiva, kuukausi ja vuosi. Jos laitteella on useampi CPU, kuten PL41 ja PL42 ja CPU:ista otetaan erilliset AG-kopiot,
niin silloin nimeen lisdtaan 1C, esimerkiksi AG1C4117, jossa 1C tarkoittaa CPU 1:sta. Tydlevyn kopion nime3 ei
muuteta alkuperdisests.



LIITE 2 sivu1(6)

SIMATIC S5 AG-kopion ottaminen logiikalta

S5-logiikan kanssa kaytetaan STEP 5-ohjelmaa. Jos ohjelma nakyy ruudulla pienena, saat sen suurennettua

Alt + Enter —nappainyhdistelmalla. STEP 5-ohjelmasta voi olla kaytossa englannin-, saksan- tai
suomenkielinen versio. Esimerkissa on kaytetty englanninkielista versiota, mutta ohjeet eivat eroa riippuen
kielesta.

Ensimmaiseksi kytkeydy kiinni kaapelilla haluttuun S5-logiikaan.
Taman jalkeen STEP 5 ohjelmassa mennaan File => Project => Set (F4)

Mikali STEP 5 on saksan kielella niin sama polku on Datei => Projekt => Einstellen (F4)

l_ Editer Test FPLC Hauegenent Dopcumentation Change Help |

1
Blacks »
DOL Divectowny > ad .-

DOs File 2 Gaue

PCP/H £ile > Save As ...
Archive ...
DOL Commandzs CtpleFiW Do apchive ...

1 D= LATAAHYLEYE™ Ll KULJFX.IHI
2 DAFHALOG™I~LATAATAMU41PFE _INI
3 D=wFEALOGCYI~LATAATAMU4IFE . TNI
4 DAPH4LOG™I%LATAAT FUL1EPE _ 1NI
5 D= SUIRE4DKOHEOH L URK<+i @FK.THI
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FiEdir PLC | F/Exit | F/Force Qut E[BIK Bgac |
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LIITE 2 sivu2(6)

SIMATIC S5 AG-kopion ottaminen logiikalta

Paina F3 nappainta vaihtaaksesi Offline->Online.

Mode:n tulee vaihtua Offline->Online

Saksan kielisessa Mode = Betriebsart

Taman jalkeen paina Enter palataksesi takaisin paanayttoon.



LIITE 2 sivu3(6)

SIMATIC S5 AG-kopion ottaminen logiikalta

Seuraavaksi mennaan File => Blocks => Transfer (F5)

Saksankielisessa Datei => Bausteine => Uebertragen (F5)

ox STEP 5 -8 x

|__ Editor Test PLC Management Documentation Change Help
Project > |

DOS Divectory > Dirvectory ...
DOE File >

PCP/M File > Compare ...
Delete ___
DOS Commands Ctr»1+Fi0 Compress ...

1 D:n. ALATAANHYLEYS “INd1KULJPX . [ NI
2 DNFEKALOG™INLATAANTAMU41PX . INI
3 D:NPKALOG™INLATAANTAMUAZPX _ INI
4 D:N\PH4ALOG™L\LATAANTEU41EPX . INI
5 DiN. . AURKS1N\KONEOH “INURK41EPX . I NI

Exiu Shifc+F4

FiEdi€ PLC " FIDBPLC | FiBdisx PLC) FIExi¢ | FiTerce Outf F/Blk Sfat |
1 Edic 2 DB 3 Bdir 4 Froj Sect 5 Trans Blk 6 Gomp Blk >

assignments with TAB




LIITE 2 sivu4(6)

SIMATIC S5 AG-kopion ottaminen logiikalta

1. Transfer block(s) -valikossa valitse Transfer from -kohtaan "(X) PLC" (Saksa = "(X) AG")

2. To -kohtaan "(X) Program file” (Saksa = "(X) Programmdatei”)

3. Taman jalkeen To Program file [kohdasta] paaset kaksoisnapauttamalla tai painamalla F3 maarittelemaan
haluamasi kansion, mihin haluat tallentaa AG-kopion. (Kuva seuraavalla sivulla)

4. Selection -kohtaan "(X) Block List [A]" (Saksa = "(X) Bausteinliste [B]). Tama siksi, etta englanninkielisessa
A tarkoittaa kaikkia lohkoja ja saksan- seka suomenkielisessa B tarkoittaa kaikkia lohkoja.

-~ ST 5 B

TransfFer hlock{s2

\. Tranzfer From
C¥3 Program £1ile [RACFRLST 5501
e 5T~ PRAL OGS ~HPLEYE 1 S CP-HOU™1
M HUOM!
®eys Prowren file RACERLST.S50] . .
. ¢ ¥ PLO — I SPRALOGY LS HY LAY S ™1 “CF-HOoU™1 Esimerkkikuvassa
.
Selection _ H
‘_E“% E%ME 1131[: o 1 l % PLC -kohta ei ole
S el ta valittavissa, koska

< History F1 > ohje on tehty
4 Solact Fa > offline-tilassa.
£ Infn F? »

EEEEEEE < Cancel ESC » £ Dptions F6E > < Help Shift+F8 »
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SIMATIC S5 AG-kopion ottaminen logiikalta

Dr/directory (Saksa = LW/Verzeichnis) kohdasta valitse polku, mihin haluat tallentaa AG-kopion.

File (Datei) kohtaan kirjoita AG-kopion nimi. Maksimi merkkimaara nimessa on 6 ja nimen lopussa on pakko
olla ST.S5D. Nimea projekti esimerkiksi AG39175T.55D, jossa:

e AG tarkoittaa AG-kopiota

o 39 tarkoittaa viikkoa

e 17 tarkoittaa vuosilukua

ot STEP § Eﬂ

Select file
Y

File [ 1
=20 PRALOC™ I HY LEY S ™1 M CE-NOU™1

rEiles CETTTITET .E50> brsdirectory
98CFR1SI . S5D s
AGCA4E9ST 85D [-h-1
NG2EE95T . E5D [-C-1
AG3I1173T .85D [-D-1
AG3I5B845T . 55D [-E-1
AGA5B6ST . 55D [-F-1
AGUUSIST .E5D [-G-1
RACFR1ET .E5D [—H-1
[-1-1
<@P
zorted: up w ame sorted: up
RACPRAST . 85D SA.4BE BA?.B2.15 14:15:34 { Select FI

< Info F? »
FREESE < Cancel FESC > { Help Shift+FR >
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SIMATIC S5 AG-kopion ottaminen logiikalta

Kun edelliset kaikki vaiheet on tehty. Aloita AG-kopion lataus Enter-nappaimella.

J Transfer hlock(s>

— Transfer from |
C(H) Program file [RACFR1ST.85D1 HUOM!
¢ 3 PLG -3 Dz PRALOG™1 ~HYLSY 8~ ~CP-HOI™1 E . |(|(|(
b P TR z % simerkkikuvassa
<3 PLC -mﬁ ALOC™1~HYL8Y 8™ “CF-HoU"4 transfer from
_Eﬁ'g"l%?;‘%“]i“ A | ]1 -rasti vaarassa
G [ t I
¢ ) Entire file b kohdassa, koska
< History F1 » ohje on tehty
< Belact Fa » offline-tilassa.
¢ Infa BR7 >
PSSR < Cancel ESC » ¢ Optians F6 > < Help GShiftsFg >

Kun kopiointi on suoritettu, olet kopioinut AG-kopion maarittelemaasi kansioon. Lopuksi mene alun ohjeen
mukaan ja vaihda Mode Online->Offline.

HUOM! AG-kopio ei sisalla kommentteja eika symboleja, joten on tarkeada ottaa myos tyolevysta kopio
talteen AG-kopion ohella.
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SIMATIC S5 AG-kopion palauttaminen logiikalle

S5-logiikan kanssa kaytetaan STEP 5-ohjelmaa. Jos ohjelma nakyy ruudulla pienena, saat sen suurennettua
Alt + Enter —nappainyhdistelmalla. STEP 5-ohjelmasta voi olla kaytossa englannin-, saksan- tai
suomenkielinen versio. Esimerkissa on kaytetty englanninkielista versiota, mutta ohjeet eivat eroa riippuen
kielesta.

Ensimmaiseksi kytkeydy kaapelilla kiinni haluttuun S5-logiikaan.
Taman jalkeen STEP 5 ohjelmassa mennaan File => Project => Set (F4)

Mikali STEP 5 on saksan kielelld niin sama polku on Datei => Projekt => Einstellen (F4)

|__ Editor Test PLC Hq&manent Documentation Change Help |

1
Blacks >
DOS DPivectory > ad .=s

oS File > Saue

PCP/H £ile > Save fAe ...
Archive ...
DoS Commands CteleFi@ Do apchive ...

Dz S LATAAHYLEYE™ 1 41 KU LJFX . 1M1
Dz5PHALODG™ 1 LATAATANU 41 _ I NI
D= FHEALOG I LATAATAMUAZFRE . THI
D=5 PHALOG™ 1 LATAAT EU41 B _ ITNI
D= SURE4LKONEOR LS URK41 BFK . INI

Shif c+F4

F Rl PLE FlExlt | F/Force dut Pl Blk Sgat
3 Bdir 4 Proj Sett 5 Trams Hlk 6 Gomp Blk *>
nnents with TaL
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SIMATIC S5 AG-kopion palauttaminen logiikalle

Paina F3 nappainta vaihtaaksesi Offline->Online.

Moden tulee vaihtua Offline->Online

Saksan kielisessa Mode = Betriebsart

Taman jalkeen paina Enter palataksesi takaisin paanayttoon.
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SIMATIC S5 AG-kopion palauttaminen logiikalle

Seuraavaksi mennaan File => Blocks => Transfer (F5)

Saksankielisessa Datei => Bausteine => Uebertragen (F5)

cv STEP 5 | - | &

l_ Editor Test PLC Managenent Documentation Change Help
Project > |

DOS Dirvectory >
DOE File 2>

PCEP/M File > Compare ...
Delete . __

DOS Commands Ctr1+FiB | Compress ...

1 D:No ALATAANHYLEYS V15N A1KULJPX . [ NI
2 D:NFRALOG™INLATAANTANUGIPX . INI
3 D:NPRALOG™INLATAANTAMUAZPX _ INI
4 D:N\FPH4ALOG™1\LATAANTEU41CPX . INI
5 DiNL AURKSIAKONEOH “INURK41(EFPX . I NI

Exit Shifc+F4

FiEddi€ PLC: FIDRPLC | FIBdiw PLE] FiExdt. . FiForce Out FIBlk Stat
1 Edic 2 DB 3 Bdir 4 Proj Sett 5 Trans Blk 6 Gomp Blk »>

——  Other key assignments with TAB
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SIMATIC S5 AG-kopion palauttaminen logiikalle

1. Transfer block(s) -valikossa valitse Transfer from -kohtaan "(X) Program file"” (Saksa = "(X)
Programmdatei”)

2. To -kohtaan "(X) PLC” (Saksa = "(X) AG")

3. Taman jalkeen Transfer from Program file [kohdasta] paaset kaksoisnapauttamalla tai painamalla F3
maarittelemaan mista kansiosta AG-kopio tuodaan. (Kuva seuraavalla sivulla)

4, Selection -kohtaan "(X) Block List [A]” (Saksa = "(X) Bausteinliste [B]). Tama siksi, ettd englanninkielisessa
A tarkoittaa kaikkia lohkoja ja saksan- seka suomenkielisessa B tarkoittaa kaikkia lohkoja.

& STEP § - || x
\. e Transfer block{s>
Tranzfer from
{HY Program file [RACFRL8T .35D1
\ £ 3 PIG =3 PHAL DG ~HY LEY S ™1 5GP —HOU ™1
t
N 55 Progran £1le FRAGFRIGT 5501 HUOM!
¢ > PLC 2=~ PRALOG™1LSHY LEYS™1 < CF-HOU™1 . .
~N - Esimerkkikuvassa
b SPEAL TIRU ] :
[H -
S i it & - PLC -kohta ei ole
nries BONE valittavissa, koska
£ History L > hi h
£ Select F3 » ohje on tehty
£ Info B2 > offline-tilassa.
EERSEEEE < Cancel ERC > { Opriana F& 2 € Help Shift+FR >
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SIMATIC S5 AG-kopion palauttaminen logiikalle

Dr/directory (Saksa = LW/Verzeichnis) kohdasta valitse polku, mistd AG-kopio tuodaan.

Files (Dateien) kohdasta valitse haluttu AG-kopio tuplaklikkaamalla tai valitsemalla oikea AG-kopio ja
painamalla Enter nappainta.

== STEP 5 - O] x|

Select file

File [ 1
=0 PHALOC™ 1« HYLEY ™1~ CF-NOU ™1
rFiles CIPTTTTRT L ERDY Dr-directory
QHCFR1ST . S5D e
AGA4RAPST S5 [fA-1
o AG2LAPET . 85D [C-1
r AGI1178T . 85D [D-1
AG3I5A45T . 55D [-E-1
AGA5BeST . 55D [-F-1
AGUHUESISET 85D -1
s RACFRAET .ECD [H-1
[-I-1
{@P
zoprted: uyn [1H ame sorted: Ik
RACPRAST . 851 GA. 488 B?Y.A2.14% 14:45:34 . Belect Fx
{ Info Fd 2
EREESE < Cancel ESC > { Help Shift+F8
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SIMATIC S5 AG-kopion palauttaminen logiikalle

Kun edelliset kaikki vaiheet on tehty. Aloita AG-kopion siirto logiikalle Enter-nappaimella.

3 P : Transfer block{z}
e Fransi er ¥rom
(%) Program file [RACFRiST.85D1 HUOM!
L 3 PLAG 3D PRALOG™1~HYLSY 5™ ~CP-HOUI™1 E . k|(|-(
— to simerkkikuvassa
{Hy Program {ile [m]
_Eﬁglégl‘:;',’l:“lht = | ] kohdassa, koska
G [ t I . .
€ 3 Entire £ile 2 ohje tehty offline-
€ Historw Fi » tilassa.
{ Soclect F3 >
{ Info Féd )
PEEEEEEEE < Cancel ESC » ¢ Options B6 > < Help Shift:Fg >

Taman jalkeen olet ladannut AG-kopion CPU:lle. AG-kopio ei kuitenkaan sisalla symboleja eika
kommentteja, joten on tarkeaa, etta ladattu AG-kopio tasmaa tyolevyn kanssa.
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SIMATIC S7-200 AG-kopion ottaminen logiikalta

S7-200 logiikoiden ohjelmoinnissa kdytetadn STEP 7-Micro/Win -ohjelmaa.

1. Kytkeydy MPI-piuhalla kiinni S7-200 CPU:hun.
2. Luo uusi projekti.
3. Avaa Set PG/PC Interface
e Esimerkkikuvien koneessa on CP711 -ajurit, joten yhteydeksi valitaan "CP5711 (PROFIBUS)
<Active>”. PG/PC:n ajurit saattavat kuitenkin olla vanhempaa mallia, jolloin yhteysmuoto on eri.
e Valitse "Properties” ja sieltd "PG/PC is the only master on bus”, address ”0”, timeout "1sec”,
Transmission Rate “9,6 kbps”, Highest Station Address “126” ja Profile “Universal (DB/FMS)”

Th GX M BC Dvbig Tok Vs Tep
O@d &b sBe - VR a2z N D e B FEE A 00SE
Sar +sAAA Y

cows Fuh | LLOP (OLP | PO Adeter | b
Accens Pew ol the Ao dn

moroes ] Mode |
St Parwnaes:
P FGPC 0 4 oy ek o b

(Shardord bor Mera AN | e =

IWptace Paswets f1gwert Used
CPTMPFIRRIS e [ Tirens tee K|

Wosrrvy - @ Nk e meter:

G557 (FwA_FAST_LOAO)

W) [ M e [t <]

WOEHIMIRE Ao = gt Slabin ko = |
£ ’ Pl e
R e el $lanciae d
Somrear caone paocessod CPET1 T b e
PEOF UL Hetnat | L
Irdacns Bun Parevebor: .
A e e ] PTs—
I Gkt wt i el cordpssbon:
G ) im | e 3 e 3
"'"I;"v
e
-gu-. o | swow | Cocd | W |
Lrvew:
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SIMATIC S7-200 AG-kopion ottaminen logiikalta

4. Seuraavaksi avaa Communications ja sielta tuplaklikkaa "Double-Click to Refresh” paivittaaksesi
verkon tila.

Jos PC/PG ja logiikan yhteysasetukset ovat oikein, niin CPU:n pitaisi loytya.
5. Taman jalkeen paina OK.

T ISTEP 7 Micre/WIN - Projectt

Fie £k Yo 10 Debuz Touls Wandcms Hep
[o=aen smn - vmazun B [RE @B w56k
]'.-- oA j»;[;{ | i&t WL | Vot o & 25

- Pasct

| a@uwhmuw

B cruz4REL o

| ¥ 8 PrganBock
| & (& Syndol Tabke
! [0 Cho [} od

SirtelTehn

Shakss Chast CPUZGRELOI T

[V Udate PLE bypa in projct
- Netvacek Pararmmlons
N Inksface cgh)
Sinem Blck Pittoei: FPROFIBUS
lﬁ NO3 1
2 Fickms Sefion (HSA) 126
Cozes Relarence
[T Supports nifipls masders
3 Tranamission Hate
Connirbstons Beud Rae: 96 kbpe

™ St o bt retas \

Sek PO Werfocn | Concel |




SIMATIC S7-200 AG-kopion ottaminen logiikalta

Ndin on PC/PG yhdistetty logiikkaan. Seuraavaksi
6. Paina "Upload”-painiketta

7. Avautuvasta Upload -ikkunasta varmista, etta Program Block, Data Block seka System Block ovat
valittuna ja taman jalkeen paina Upload

U |STEP 7 Micra/Wh{ - ag Mapien alts “aon
fhe £

dﬁﬂ&[b A

E LB elmE RES|e N6 S
oo [EiN A ARA R T2 |1_fo--o ik

Upload
PP Conee claan

Uz the Opacnz bukon to select Hocks 10 upload.

Female Addimes 2

emm.

Ol:AUuhndhbm mmmmmuuuhmwm»lu

'X|

CPU14RELOLIT

Opkens 2 l

Opbors

WV PogamBlocs

|
dmmbg—l.

[ uwen ]

W~ Dats Blcch
v Spsherm Bleck
I~ Amcpes

™ DataLog Conbganion:

H =

Tovmunicnm

i

'E a
SHPGEL
ialacs

@ Click for Help and Support

[ |

From PLC
From PLC
Fron PLL

W Cloee dabg on ruccsss
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SIMATIC S7-200 AG-kopion ottaminen logiikalta

Na&in olet ottanut AG-kopion logiikalta luomallesi uudelle projektille. Se ei kuitenkaan sisalla symboleja eika
kommentteja. Lopuksi tallenna se haluamaasi paikkaan File => Save As...

[=|STEP 1 Micro/WIN - ag kopion ottaminen
UE EAt Vew PLC Debug  Fook Windows  Help

New Cuk+h ...,.,I,.
op=n Ctri+0 ‘B[H‘—— 2 ml
Closs Wan |3+ > -0
200 cols LT
Set Passmord. plt
Frpat..
Export...
Ugload,, Cul+u
Dowrioad... D L
Craate Lbvary i ——
Add'Remove Libraries, .. lmUGRAM COMMENTS
Lezaly, Moot Nelwork 1 Hetwark T
ren k.. ([ —
Prnt Praview
Prnt.. Chrib H
o
1 ag-kepion otkaninen
2 TMP4 Lutra
3 Coprogram Fles|, | K3 Lura
e [ e
Evk
[ &0 Logea Ooericns Y
+ (A Move
+ (1 Frogan Cornal
# () ShitvRotae
+ (3 Strng
+ () Tk Network 3
|2 Timers I
Lbrvanes
# (g8 Cal Subroutines ;I
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SIMATIC S7-200 AG-kopion palauttaminen logiikalle

$7-200 logiikoiden ohjelmoinnissa kdytetdan STEP 7-Micro/Win ohjelmaa.

1. Kytkeydy MPI-piuhalla kiinni $7-200 CPU:hun.
2. Avaa AG-kopio File => Open...
3. Avaa Set PG/PC Interface
e Esimerkkikuvien koneessa on CP5711 ajurit, joten yhteydeksi valitaan “CP5711 (PROFIBUS)
<Active>”. PG/PC:n ajurit saattavat kuitenkin olla vanhempaa mallia, jolloin yhteysmuoto on eri.
e Valitse "Properties” ja sieltd "PG/PC is the only master on bus”, address "0”, timeout "1sec”,
Transmission Rate “9,6 kbps”, Highest Station Address “126” ja Profile “Universal (DB/FMS)”

e Bl Ven MG Delwg Twh Wiebes e
NSO SR IR - VR ax D re B RITH% 0L
wl S 3RR YD

Accunt P | L6 200P | PO Adyte L Irie| PROFECS |y |
Staton Parmetery
"y e =
om Ehw Stiie Pt o 6 200k Aon 1@ PEAL ki e ooty mvecter o bes
<l . E
’f foranamd fee e WY r i
vt T
i oot ica Ponomeses Asayvent Lion T
PR IPRIIFBK) [P ] ] —
WOSn A | Depuerct Phstvcak Py vovatex:
WO APPSO = T | T
et Slyon ode iz =l
Plle 0P
Yt warmste swsgwert o i
o mostore soera (AT b o U o Cisfmer)
FAOFEUS femes) ke
eeces o Faravem
Lt Hewim aed
Pt
e }r‘ T ke v s et cond gasbon
[ [(Coea ][ e ] J 3 -
T | -
v g e
- —ect C | ] e |
awe
Cal Subrousees
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SIMATIC S7-200 AG-kopion palauttaminen logiikalle

4, Seuraavaksi avaa Communications ja sielta tuplaklikkaa "Double-Click to Refresh” paivittaaksesi
verkon tila.
Jos PC/PG ja logiikan yhteysasetukset ovat oikein, niin CPU:n pitdisi [0ytya.

5. Taman jalkeen paina OK.

T STEP { Micro/WIN - Projectt

Fle Lo “ 1C Debad Andces  Hep
loee an amn v YBaz ay Ofre[EE EET|a0% 666
: [’, $ AR I I 3 4 - |4eal

@ cruz4REL 20
|+ g8 Prgan Bk

(N ST | | & (@ Spnbol Tabks
s, B he [

Syl Tk

CFE711FROFEUS
: Lecst 0 IS fdden )
=) Retate: m \ . CPUIGRELOT !

Shatiis st PLC Type CPUZIGAEL O T \ Addiers 2

3
n
DataBinck [V Ui PLC bypa inpropd
- Hebvatk Porarmabors
; ‘\P Inksvace 5

it Puecca FROFIBS
T Mok 1
]

Fighesst Sston (HSA) 126
[ Supsorts nuipls mevsers

Crzse Rebrenze

= Tranermvscion Azte
Connkisine Beud Rae 96 kbpz ~

B [ Senrin o e e
=[5
)

e
.,I:'t' :?;F:: Set PGC hfertocs ’ Conced
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SIMATIC S7-200 AG-kopion palauttaminen logiikalle

Na&in on PC/PG yhdistetty logiikkaan. Seuraavaksi:

6. Paina "Download”-painiketta.
7. Avautuvasta Download ikkunasta paina "Download” aloittaaksesi AG-kopion lataaminen logiikalle.

T STIP. 7 Micio/WIN - Projoctt

TETETET eug Tol Wik "
D@G|BR =R - AR 2z B|re@AEEE| S b6
Gt G ARBAR FE 3 2eo 0(

Downtoad x
-] PPl Connoction
Proprein Blich, 1z I Opherss button i seked Hecks o downioad
FAencts Sddesy 2 CRUN4AELOT 1Y
i', Cich O pwrond o begn g
o b
S Opiors 2 [ Omwiood | Lol |
g Dpbors
P 3
e 7 PrganBbdk To PLE
[Tk v Data Bk To PL
|a ¥ Systom Binck To AT
L Frtaorcn [~ Aecees

[T DataLog Conbaushons

[¥ Chie daiog on success
- 14 Pronpt co FUN o STOP
@ Click for Help and Support ¥ Provpt on STOP 1o UM

T
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SIMATIC S7-300 ja S7-400 AG-kopion ottaminen logiikalta

1. Muodosta yhteys haluttuun logiikkaan esimerkiksi MPl-kaapelilla.
2. AG-kopion ottaminen aloitetaan luomalla uusi projekti.

% SIMATIC Manager
FE8 PLC  View Options Window Help

Chrl+M

‘Mew Project” Wizard...
Oper... Chr40

57 Memary Card b
Memary Card File b

Delete. ..
Rearganize, ..
Manage...

frchive..,
Retrieve...

Page Setup

1 PL42v003 (Project) -- D:\PK4 logikat\PL_421PL42v003
2 TESTALS (Project) — Driikaikenlaistal ROOPE! Testaus
3 PL41+004 {Project) - D:\PE4 logikat\PL_41\PL41+004
4 PL41_22092017 (Project) - F:\, . \PL41_220

Exat alt+F4
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SIMATIC S7-300 ja S7-400 AG-kopion ottaminen logiikalta

3. Anna otettavalle AG-kopiolle esimerkin mukaan nimi. Esimerkiksi AG1C3917, jossa:
a. AG tarkoittaa AG-kopiota
b. 1C tarkoittaa CPU1:sta
c. 39 tarkoittaa viikkoa
d. 17 tarkoittaa vuosilukua
4. Storage location -kohtaan valitse Browse-painikkeella, mihin kansioon haluat AG-kopion tallentaa.

Usen projects | Librariaa | Mubipiojects |
Merme | Stoezge palh A
&MUFE_PLZLFIH.&L DMt logikat 00751
BB 20077 FL21_Final DeAbuut logik:=r 007714
BByt oest DAl Ingik=hCHOZ I
BRCL1 AT O:bduut logik.2t\CH A4 67
&Hyl\s&mhn_ﬂﬂl DMt logikathSaha 5 Fobyzln.
@Ih‘udbﬁke:kus DAPEA logik st PROJEETI T Ime
| S-S Prlkdoa oIl Ll 2l 3
4 | L]
B 2l magpen o e
Mame Tyme:
| Piogcl -
|
: B FlEr
Sharage Iocobior [pokhl:
IDkngram FleshSiemenshSteps b= Tproj = I
Mk | Cancel | Help l
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SIMATIC S7-300 ja S7-400 AG-kopion ottaminen logiikalta

Nain olet luonut uuden projektin.

T SIMATIC Manager - AG1C 220917
Fle Edt Inset PLC Wiew Options Window Hep

e 39| ¢ o | D 2 % % 5|5 |[<HoFiees -7 BE REM e

B0 AGACZZ091T -- DADhjaiden_lusniiap]ed 309
Ep e R WPIMT)
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SIMATIC S7-300 ja S7-400 AG-kopion ottaminen logiikalta

Itse AG-kopion ottaminen tapahtuu PLC => Upload Station to PG... -valikon kautta.
I SIMATIC Manager - AG1C22091 7

Fie Edt Ins=rt BzEs Yien Cptions ‘Window Help

= | BT /7 Aocess Rios v

B AG1C272091 ELV'I.|LIdIJ CirhL
Cerfigare.. ChrHk

complle ard Dawnkad objecrs, .,
Uplzad ta PG

Upload Stabon bo PG

Copy RAM ko ROM. .,

Downlaad Uzer Program ko Memory Card

Canvz ko Memary Card, .
Retrieve From Memory Card,,

Mansoes MT System..

Drive ]

Lisplay Azcesable Nodes

“hargz Maodule [denbFication ..
CFL I"1=3'.ICLC3. "
Display Force Yalues

Monitcr JModify Yarizbles

Diagrostic/5ekting ]
FROFIGUS 3
Edit Etnernet Made. ..

B30 PafPC
Cancel PGPC Assignment
|piane Frmsare

Update the Cperating Syskzm, .,

S Servize Deka .,
focess Address .
T




LIITE 6 sivu5(5)

SIMATIC S7-300 ja S7-400 AG-kopion ottaminen logiikalta

Select Node Address -valikossa paina View etsiaksesi CPU:n, johon olet liittynyt kaapelilla.

Kun CPU on loytynyt paina OK aloittaaksesi AG-kopion lataamisen luomaasi projektiin.

Nyt olet tuonut AG-kopion luomaasi projektiin. AG-kopio ei sisalld symboleita eikd kommentteja, tdman
takia on tarkea ottaa talteen myos tyolevy, joka sisdltada kommentit ja symbolit.

Lopuksi tallenna projekti.

HUOM! Muista siirtdd AG-kopio myds kyseisen laitteen muistitikulle!
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Téssd ohjeessa kasitellddn AG-kopion palauttamista logiikalle ilman NetPro-ohjelman kdyttdmistd. Tatd tapaa tulisi kayttas
vain, jos logiikalla ei ole verkkorakennetta.

Jos logiikan CPU-kortti joudutaan vaihtamaan, tai jos logiikka on jotenkin muuten mennyt tilaan, josta sitd ei saada
palautettua, niin silloin tadytyy CPU:lle ladata viimeisin, toimiva AG-kopio.

AG-kopion latauksen voi tehda sekd Ethernet- tai MPl-kaapelin kautta. Koska samassa Ethernet-verkossa voi olla useita eri
CPU-kortteja ja AG-kopion lataaminen vie systeemin datan sithen logiikkaan, joka AG-kopion HW-konfiguroinnissa on
verkkokortille maaritelty, niin kaikista varmin tapa on kayttad MPl-kaapelia ja tdt3 tapaa tulisikin kayttda aina. Nain
varmistutaan myos siitd, ettd ollaan varmasti kytkeydytty juuri oikeaan CPU-korttiin.

Ensimmadiseksi avataan Simatic Managerilla oikean CPU:n viimeisin AG-kopio.

H SIMATIC Manager - PL21_PL22-Kuljeltimel

| B E M A2

Object name Symbalic name Type Size | Autho Last modified
El] Hardware - Statice configuration 105264016 09: 2647 AW
CPU 315F-2 FH/DP -~ (] 03723010 033814 Ph
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle
1. Yhdista PG/PC logiikkaan.

2. Valitse Simatic Managerin hakemistopuusta CPU aktiiviseksi.
3. Avaa HW Config kaksoisnapauttamalla Hardware.

ESIMATIC Manager - PL21_PL22-Kuljeltimel

File Edit Insett PLC  Yiew Ophons Window Help
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Paina Download to Module —painiketta ladataksesi hardwaren logiikalle. (Esimerkkikuvassa Download to
Module —painike nakyy harmaana, koska esimerkki on tehty offline-tilassa.)
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[ HW Config - [SIMATIC 300 Station (Configuration) -- PL21 PL22-Kuljettimet]
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Download to Module -painikkeen painamisen jalkeen tulee seuraava ilmoitus. Tahan painetaan OK.

Taget modes
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Myos seuraavaan ilmoitukseen painetaan OK. Jos kaikki on kunnossa, niin taman jalkeen lataus pitadisi
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Stop Tarpel Modules Ei
The talaweng moddss sl be stopped for inading of e srdem
data. . .. . . . . .
Jos CPU on RUN-tilassa, niin silloin tulee ilmoitus, etta se
HModule | Racks | Siot . ]
CFU 4162 OF o 3 laitetaan STOP-tilaan.
Paina OK.
o Cacal |  Hep |

Latauksen jalkeen systeemi kysyy laitetaanko CPU RUN-tilaan, t3ssa vaiheessa vastataan NO.

PLC Download to Current Project Selected Stations (13:4363)

The modue CPU 416-2 DF [R 045 3]iz in the STOP mode.
' Do pow wanit o start the rnodule now [complete restart)?

ves | No | Details .

Periaatteessa logiikan laitteistot on nyt maaritelty, mutta jos CPU-kortti oli tyhja, niin silloin siella ei ole
vield mitaan ohjelmia.
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Ohjelmat saadaan ladattua logiikalle avaamalla Simatic Managerissa vasemmasta hakemistopuusta Blocks-
valikko aktiiviseksi.

Jokaisen CPU:n alla on oma Blocks-kansio, jossa on kunkin CPU:n kayttamat ohjelmalohkot.

¥ SIMATIC Manager - [42A13911 - D:\Projects\Raumatoulutus\S 71 2a13911]
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Taman jalkeen valitaan kaikki lohkot aktiiviseksi esimerkiksi kayttamalla Edit == Select All -valikosta.

K SIMATIC Manager - [42A413911 - D:\Projec
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Taman jalkeen klikataan kerran System data-kansiota samalla pitaen Control (Ctrl) painiketta pohjassa.

ESIMATIC Manager - [42A13911 -- D:WProjects\RaumaKoulutus\S 734 2a13911]
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Nain saadaan valittua kaikki lohkot (FC, FB, DB yms.) lukuun ottamatta System data-kansiota.

ESIMMIL’ Manager - [42A13911 -- D:Wrojects\HaumaWoulutusis /%4 2a13911]
) Fle Edit Insert PLC View Options window Help

D& &'« & B3 |di
B 42013511 =
= CPUZ

=[] crPu 1620P
=21 &7 Piogram(1)
@] Sources
~{ZH Blocks
= CP 4431




LIITE 7 sivu10(13)

SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Valittujen lohkojen lataaminen tapahtuu painamalla Download -painiketta.

I SIMATIC Manager - [42413911 - D:\Proiects\RaumalKoulutus\S 7\ 2a13911] =T
- 5
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Systeemi kehottaa varmistamaan lohkojen jarjestyksen.

Tahan vastataan OK.

Download (294:5) X]

Check the scquence of the blocks that is required for the
! comect function

0K | Cancel | Help |

Jos CPU-kortti on tyhja, niin seuraavaa ilmoitusta ei tule. Mutta jos CPU-kortti ei ole tyhja, niin systeemi
kysyy kirjoitetaanko vanhojen lohkojen paalle. Tahan kohtaan painetaan All-painiketta.

Insert Organization Block

'E |The object ‘081" dready exsts. Do you want to overwte it?
L

e Al No None Corcel Help
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Nyt logiikalle on palautettu kaikki ohjelmalohkot, seka systeemin data, joka meni NetPro-sovelluksen
kautta.

Seuraavaksi CPU voidaan siis laittaa RUN-tilaan valikosta:

PLC => Diagnostic/Setting => Operating Mode

_[,i SIMATIC Manager - [42A13211 - D:WProjects\RaumalKoulutus\S T4 2a139211]
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SIMATIC S7-300 ja S7-400 AG-kopion palauttaminen logiikalle

Walitse aina Warm Restart.

Operating Mode El
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Jos logiikan CPU-kortti joudutaan vaihtamaan, tai jos logiikka on jotenkin muuten mennyt tilaan, josta sita
ei saada palautettua, niin silloin taytyy CPU:lle ladata viimeisin, toimiva AG-kopio.

AG-kopion latauksen voi tehda seka Ethernet- tai MPl-kaapelin kautta. Koska samassa Ethernet-verkossa
voi olla useita eri CPU-kortteja ja AG-kopion lataaminen vie systeemin datan siihen logiikkaan, joka AG-
kopion HW-konfiguroinnissa on verkkokortille maaritelty, niin kaikista varmin tapa on kayttdaa MPI-
kaapelia ja tata tapaa tulisikin kdyttda aina. Nain varmistutaan myaos siita, etta ollaan varmasti kytkeydytty
juuri oikeaan CPU-korttiin.

Jos jarjestelmassa on useampi CPU, niin silloin hardwaren lataaminen tulisi aloittaa "kaanteisessa”
jarjestyksessa eli viimeiseksi ladataan CPU1, koska talla tavalla saadaan varmistettua, etta CPU1 varten
esimerkiksi CPU2 ja CPU3 ovat valmiita vastaanottamaan dataa.

Ensimmaiseksi avataan Simatic Managerilla oikean CPU:n viimeisin AG-kopio. (Esimerkissa kaytetaan PL42
AG-kopiota)

L/ BIRATIC Manager - [4781 3811 - 0P rojects Pasem sl ulst wsds TH2al 3911]

B8 e Edt Iresrt PLC ¥ew Colios Wrdow Heb -8 X
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-
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Tassa ohjeessa on kerrottu varmuuskopion lataus logiikalle NetPro-ohjelman avulla. NetPro-ohjelmaa tulee
kayttaa aina, jos logiikassa on verkkorakenne (esim. Profibus tai Ethernet).

1. Yhdistd PG/PC CPU:hun.
2. Valitse Simatic Managerin hakemistopuusta CPU:n alta CPU aktiiviseksi.
3. Tuplaklikkaa Connections-kansiota oikeanpuoleisesta valikosta (NetPro-sovellus kaynnistyy)

P SIMATIC Manager - [42413911 -- D:\Projects\Rauma\Koulutus\S7\d za1 391 1] Mi=13
 File Edit Insert PLC Wiew Options ‘window Help -8 X
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

NetPro-sovelluksessa on maaritelty kyseisen CPU:n yhteydet, eli ne pisteet, joiden kanssa se
kommunikoi. Muun muassa toiset CPU:t ja valvomo-pc:t.

Listan saa nakyviin klikkaamalla kehikon CPU-korttia.
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13F Uniiren ET conmaction ] Mo CPUE] P02 1921861 233 102188.1.231 ki
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

NetPro-sovelluksen Download-painike lataa valittuna olevan CPU:n hardware konfiguroinnin

logiikalle, vieden mukanaan juuri nama yhteyspisteet.
HUOM! Tarkista, etta olet MPl-yhteydessa oikeassa CPU:ssa, johon olet lataamassa hardwarea!
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Download-painikkeen painamisen jalkeen tulee seuraava ilmoitus. limoitukseen vastataan Yes.

PLC Download to Current Project Selected Stalions (2263:35)

'2 Thig action will ovenaite the configuration data that are alieady on the

PLC(s). Do you stil weant to download?

Yei Mo | Help

Stop Target Modules Ei
The ellaving mockdes wit be siapped far nading of e gysiem Jos CPU on RUN-tilassa, niin silloin tulee ilmoitus, ettd se
Modide | Ancks | Siot laitetaan STOP-tilaan.
CPL 4162 OF i} =
Paina OK.

o Caresl | Helo
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Latauksen jalkeen systeemi kysyy laitetaanko CPU RUN-tilaan, tassa vaiheessa vastataan NO.

PLC Download to Current Project Selected Siations (13:4363)

The module CFU 416-2 DF [R 045 3]isin the STOP mode.
'I h Do you want bo start the module now [complete restart)?

Yas | Mo Datals... |

Useissa tapauksissa hardware konfigurointi kannattaa ladata kahteen kertaa NetPro:n avulla. Varsinkin

PL41 ja PL42 on ollut tapauksia, joissa hardware konfigurointi on pitanyt ladata kahteen kertaan, jotta se on
mennyt sisaan oikein.

Periaatteessa logiikan laitteistot on nyt maaritelty, mutta jos CPU-kortti oli tyhja, niin silloin siella ei ole
viela mitaan ohjelmia.
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Ohjelmat saadaan ladattua logiikalle avaamalla Simatic Managerissa vasemmasta hakemistopuusta Blocks-
valikko aktiiviseksi.

Jokaisen CPU:n alla on oma Blocks-kansio, jossa on kunkin CPU:n kayttamat ohjelmalohkot.

5” SIMATIC Manager - [42A13911 -- D:\Projects\RaumaMoulutus\S 7V 2a13911]

@ Fle FEdit Tnsest PLC Wew  Opbions  Window  Help = | |
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Taman jalkeen valitaan kaikki lohkot aktiiviseksi esimerkiksi kayttamalla Edit => Select All -valikosta.

I SIMATIC Manager - [42A13911 -- D:VProjec
5P Fils §L0ll Insert PLC View Options Window

Cut Chrh-x t
Copy Chrk-C
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Taman jalkeen klikataan kerran System data-kansiota samalla pitaen Control (Ctrl) painiketta pohjassa

rg’SIM.&TIC Manager - [42A13911 -- D:WProjects\RaumaKoulutus\S7442a13911]
EP Fle Edt Insert PLC Yiew Options Window Help

T X
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

MNain saadaan valittua kaikki lohkot (FC, FB, DB yms.) lukuun ottamatta System data-kansiota.

ESIMMIL’ Manager - [42A13911 -- D:Wrojects\HaumaWoulutusis5 /442213911
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N 27 | 4 B del @ 2 | < NoFiker> ~ || Wae mEMI

= &P 425139 55 5ytem dafs s =10B33 3 UEEY
- [ CPU3 o2 . 0554
=i CPU 416-2 DP 7 =1 0100 1 0B 101
=1-{g7] 57 Piogram(1) 1812 ¥ =1 FB45] o
] Sources : SVFC26 M FC27
{8 Blocks C2g 30 MLt MFCI
=+ :E: CF 4431 C105 el FC7 30
i Al
w1 FC200
s FCZ230
TAFCI14
w2 FOTH
A FAT
=8 FC4R]
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Valittujen lohkojen lataaminen tapahtuu painamalla Download-painiketta.

Q SIMATIC Manager - [42A1713911 -- D:Wrnjects\RaumalKoulutus\s /A4 2a7 3911

= CPU3
= [§ cruss-20P
=1z 57 Progrem(1)
(O] Souces
{ZH Blocks
+ Jf cP a3

Frees FL bo get Help.
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Systeemi kehottaa varmistamaan lohkojen jarjestyksen.

Tahan vastataan OK.

Downlead (294:5) X|

Check the scquence of the blocks that i required for the
! comect funchion

oK | Cancel | Help |

Jos CPU-kortti on tyhja, niin seuraavaa ilmoitusta ei tule. Mutta jos CPU-kortti ei ole tyhja, niin systeemi
kysyy kirjoitetaanko vanhojen lohkojen paalle. Tahan kohtaan painetaan All-painiketta.

Insert Organization Block

'E |Thech'|ect'ﬂE1'Eirea:b ewists. Do you wark to overwte it?
L

e Al No Nore Earcel Help
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Nyt logiikalle on palautettu kaikki ohjelmalohkot, seka systeemin data, joka meni NetPro-sovelluksen
kautta.

Seuraavaksi CPU voidaan siis laittaa RUN-tilaan valikosta:

PLC => Diagnostic/Setting => Operating Mode

5.1i SIMATIC Manager - [42A13211 -- D:Projects\Rauma\Moulutus\S 74 2a13211]
Ep Fie Edt Insert JEES Wiew Options Window  Help
Atcess Rights »

Dowirload L
Configure.. CErl K
Compile and Dovenload Objects...

_I.I_I. .
|Upload Station ta PG,
Zopy RAM bo ROl
Dowerload Liser Frogram bo Memoery Card

Sewm b Mlemary Card. .
Retrieye From Merory Card.. .

e

R e Py i

Display Accassible Modes

Charpge Madube Tdetifcaton. .,

CFU Messaoes.. .
Display Force Yalues
PRardne ladify ariables ————

[agnostic/Setbng gt dwaie: Tiagrashcs
Madue Inforratian. . Qi

FROFIBUS
Felt Frhweenst Blade

Creratig Mods...
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Walitse aina Warm Restart.

Operating Mode [?l
Pl [ﬂ*.‘l?g'!l\DFU?-.l:P.l 62 DPST Pragiam(l]
Oindree  Dlidied pamibes: EEST S16-2M050480
Hems AU 416-2 DF
Cuarent Dpesating Mode: STOP ‘warm Aestart
Coolid Aleatowl
_foResat |
__swe |

Cunend mode swilch posion AU%

Cuament leves of peatecion: 1

Freagon for cument level of probecton

Lozest np e imsting mede- AL

Updat= | { e | b | v e ew . . . .
Taman jalkeen logiikan tulisi olla RUN-tilassa.
Systeemi kysyy vield oletko varma. Tahan vastataan Yes. o T
Orire  (hvadar reambar EEST 4152005 IREl
T
Coasar D pssg Mrcis FLik
'*-\. Path: 4221331 1\CPUSACPU 4162 DPAST Programi(1] !
Do pow wark lo cainy out & wam restat? S0P

Cursars pacche twvich pacitor: Fiiw
Coanrd bvved af papiaebgrs 1
Flomson for covwnl bewl ol puaiecion -+
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Kun kaikki CPU:t ovat RUN-tilassa, niin avataan TYOLEVYLTA NetPro ja tarkistetaan logiikoiden valinen
kommunikoinnin tila.
Kommunikoinnin Online-tila saadaan painamalla Connection Status painiketta. Ikkunan ylalaidasta

nahdaan, ettad ollaan online-tilassa.

Kunkin CPU:n kommunikoinnin tila ndhdaan painamalla CPU-kortti aktiiviseksi.

El

:k!z;zflatu:dxndﬁsi
:suﬁitnl*ru!aamaasi
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SIMATIC S7-400 AG-kopion palauttaminen logiikalle (NetPro)

Jos kommunikointi nayttaa punaista neliota ja Not available -tekstia, niin kommunikointi on poikki jostain

syysta. Talloin taytyy logiikoiden hardware konfiguroinnin lataus tehda uudelleen. Katso sivu 4.

Jos yhteydet ovat kunnossa, jokainen CPU nayttdaa Connection status —kentassa vihreaa nuolta ja
Established-tekstia.
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SIMATIC S7-1500 logiikan varmuuskopiointi

§7-1500 -logiikan kanssa kaytetaan TIA PORTAL —ohjelmistoa. $7-1500 ja $§7-1200 logiikalle on tallennettu
myos kommentit ja symbolit toisin kuin aiemmissa sukupolvissa. Tasta syysta saat logiikalta ladattua koko

projektin kommentteineen ja symboleineen.

Tassa ohjeessa on esitetty, kuinka ladata olemassa oleva konfiguraatio PLC:ta ohjelmointilaitteelle.
Toimenpide on tarpeen, jos ohjelmointilaitteella ei ole projektia ja se on myos helpoin tapa ottaa viimeisin

varmuuskopio suoraan PLC:Ita.
1. Kytkeydy kiinni CPU:hun Ethernet-kaapelilla.

2. Luo uusi projekti, Project => New...
¢ Nimea projekti selkeasti ja valitse kansio, mihin projekti tallennetaan.

Projec: | Edit  Wews baari Onfine  OpSorm Toch  Window
i) bt 5 0
FIEEDE ol
Pigrate projact..

4 (]t
Deless prajec. Lt [
Famivar..

W Curd Randerd 5B mamazry "

Fnrecry card e "
¥

E-Haklos THakko T AGHa ki Hakdoa T#G4017
ERT-A5M t Mararmmensnoheilshatibgl
ChbkersaunarelD. Hayeke shus P4 OKD3
E-h 71500 saadhabbut seelhabos tieaspaai
E-n7-1300 teasHakku 2 letiHakkuTeas

E 70500 nesu TEETPR_MESTPROUERTVA A
ERT-0 500 nes ihesnprojekaines b projela
Cihanlautzrilocumenailog . 400K

Ex
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SIMATIC S7-1500 logiikan varmuuskopiointi

3. Mene Online => Upload device as new station (hardware and software)...

T8y Siemens - E:s7-1500 testiHAKKU1AGA01 PAHAKKU1 AGA017

Project  Edit View  Insert |Dn|ine |Dptiuns Tools  Window Help
F ™ K save project a # Goonline S+ line g® Go offline ﬁl’ mmeE :l
@ Extended go online... '
¥ Goofline Crrl+M

Devices simulation » v [ gy Metwork view "[H Device view | i

L - ]
O ﬂ'l Q Stop runtimelsimulation view ” Connections | 4 | b
M oownload to device Crrl+L Type Ad_
¥ | ] HAKKU1AG4017 Extended download to device
‘I:'Adl:l new device o]
ﬂﬁ, Devices & newnvarks D
» [gh Common data
] F:Tﬂ Documentation setl
3 % Languages & resou o

E- >napzhot of the monitor values

JUplogd from device (software)

Uploed device as new station (hardware and software)...

¢ [ Online access
b [5G Card Reader/USBE mem

Backup from online device

HMI Device maintenance »
ﬂ%? Accessible devices... CrriU
M sterecru Ctrl+Shifi+E

B stop CPU Corl+5 hift(

% Orline & diagnestics Ctrl+D
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SIMATIC S7-1500 logiikan varmuuskopiointi

4. "Upload device to PG/PC” -valikossa tarkista yhteysasetukset ja timan jalkeen paina Start search.
5. Kun laitteet ovat loytyneet, valitse listasta CPU ja taman jalkeen paina Upload.

N\

Type cfthe PRIFC interiace: | FIE [-]
PEIPCimerace: P irmelif: E2577LM Gigekit Nenark Cannaction | =) 85 64

Accessble nodes of the selected interoce:

Device | Device type Type Addrecs A address

magnplct RS20 P FHIE 192165001 Z5-63-36-B7-25-BF
131 ABCCFAT i2Ferth FMAE 152.168.02 00-30-11-14-D0-F4
magnhmi SIRATICHR FHE 19216805 IAE3IEBEESE

Online status infarmation:

4y Retrieving device inbrmation... [#]

Scan and information retrieval completed. —
-

[7] Display only emor messages

Taman jalkeen ohjelma lataa koko hardware konfiguroinnin ja ohjelmalohkot sisaltden kommentit ja
symbolit. Jos lataus keskeytyy, niin katso ohjeen viimeinen sivu.



SIMATIC S7-1500 logiikan varmuuskopiointi

6. Lopuksi tallenna projekti painamalla Save project.

LIITE9 sivu4()
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SIMATIC S7-1500 logiikan varmuuskopiointi

Jos lataus keskeytyy ja tulee alla olevan kuvan tyyppinen virhe ( Could not determine type of module XXX
offline.), niin silloin TIA PORTAL:sta puuttuu konfiguroinnissa olevan laitteen GSD-tiedosto. Jotta
lataaminen onnistuisi, tulee kyseisen laitteen GSD-tiedosto ladata esimerkiksi verkosta ja taman jalkeen
ladata ohjelmaan Options => Manage general station description files (GSD) -valikosta.

| 4 Properties |*ii Infa i_J| '/ Diagnostics |
| General | Cross-references || Compile |
gmg Show all messages |"|
hessage Gato |? Date Time
G Project Hekku1AGL017 cpened. 1ME2017F  10:24:15 AM
lﬂl Scanning for devices an interface Intel (A} 82577LM Gigab it Metwork Connection was started. TME2017  10:2434 AM
n scanning fior devices cempleted for interface Intel(R) 8257 7LM Gigakit Nenwork Connection... I0EZ017  10:24:43 Al
€3 = Stertuplood fom device 1062017 102453 Al
[} Could mot determine nyoe of module LQT offine. 7 Ioiel2017  10:2507 AWM
@ﬂ Upload eborted while uploeding from device (ermors: 1; wamings: 0. 1HE2017 102507 AM

¥ Upload aborted while uploeding from d_.
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SIMATIC S7-1500 varmuuskopion palauttaminen logiikalle

57-1500 -ohjelmoinnissa kdytetddn TIA PORTAL —ohjelmistoa. Tdssd ohjeessa kasitellddn varmuuskopion palauttamista, jos
CPU on jouduttu vaihtamaan tai CPU on niin jumissa, ettd siihen pitda ladata koko projekti uudestaan.

Tamd ohje on tehty TIA PORTAL V13:sta kdyttden. Perusperiaate varmuuskopion palauttamisesta ei kuitenkaan eroa eri
versioilla.

1. Kytkeydy CPU:hun kiinni LAN-kaapelilla

2. Avaa kyseisen laitteen varmuuskopio TIA PORTAL:iin

3. Valitse CPU ja paina Compile

¥ Siemens - Ex\s7-1500 testi\Hakku2 Testi\Hakku2 Test

Project Edit View Insert Online Opuons Tool ndow Help

3 W saveproject Z M I o W Mz 5N E B R F Goonline

Project tree o 4

Devices

EL-X: =2

* | ] HakkuZTesti
ﬁ' Add new device
di Devices & networks
s ancioviszcim
I pevice configuration
% Online & diagnostics
** Parameters

b 'l Frogram blocks
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SIMATIC S7-1500 varmuuskopion palauttaminen logiikalle

Kun Compile komento on suoritettu, niin seuraavaksi:

4. Paina Download to device L+

Jos yhteyttd ei ole vield muodostettu CPU:hun, niin aukeaa "Extended download to device” —ikkuna. Jos yhteysasetukset
ovat oikeat, niin ohjelman pitdisi |6ytdad automaattisesti CPU, johon on kytkeydytty. Kun CPU on loytynyt, paina Load.

5. Aukeavasta "Load preview” —ikkunasta paina Load aloittaaksesi latauksen CPU:lle.
* Jos CPU on RUN-tilassa tai ei ole tyhjé, niin ohjelma kysyy tésséd kohdassa, ettd laitetaanko CPU STOP-tilaan ja
ylikirjoitetaanko vanhat tiedot. Laitetaan CPU STOP-tilaan ja ylikirjoitetaan vanhat tiedot.

Load preview

Staba || Target [—— Actizn
i & * mco Feady far losding.
1 = Profechon Frotection fom unauthonzed access

Davicas conFectad 1o a0 entarprite retsark or dinecdy 1 thi
intemet mut be s ppropristely pretected sgeinst unsuthoriced
access =g by use of frewells and network segmentetion. For
rmore informaten ebout rdustnal security, please vait

] PRI KRR PTG NS COMANELE TSI BELRTTy
[ ¥ Siop medules The modules are siopped for downloading iodewce. Stopall
ﬂ b Devce configureti.. Delete and replace 3y3tem date infamget Dowmloed to device
-] F Saftvare Dovmicad saoftve re to device Cansistent download
ﬂ Tasz libranias Devaribkcad al alarm e and 1 o g Conskwe downlaad

\ [ Reresh |

e 1 concel [

Sivu 2(3)
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SIMATIC S7-1500 varmuuskopion palauttaminen logiikalle

6. Latauksen jalkeen ohjelma kysyy, laitetaanko CPU RUN-tilaan. Laitan tahan rasti “Start all” —kohtaan
ja paina Finish.

Load results
e Haws and actons aber download ng Lo device
Sews ! Tenget Message Action
'{- 'ﬂ = PLC1 Dovmicadng to device completed without ermorn.
1 ¥ Stanm modulec Stant modules & fier dovwnlcading to device. M stamal
E Finizh i | Load | Camcel 1

Nyt olet ladannut varmuuskopion laitekonfiguraation ja ohjelmat CPU:lle.
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Siemens LOGO varmuuskopion ottaminen logiikalta

Siemens LOGO:lta varmuuskopiota ottaessa taytyy huomioida, etta logiikka pysahtyy varmuuskopiota
otettaessa, joten se tulisi tehda vain koneen ollessa seis.

LOGON kanssa kaytetaan LOGO! Soft Comfort-ohjelmaa.

LOGO versio 7 ja 8:ssa liityntaan kaytetaan Ethernet-kaapelia ja aiempien versioiden kanssa kaytetaan
LOGO! PC-kaapelia.

Ensimmaiseksi kytkeydy kaapelilla kiinni logiikkaan. Taman jalkeen:

1. Paina "Go Online” -painiketta.

BB/ XXHE /D> IR BE |~
Diagram Mode Network Project

Network view

I Add New Device. ' Go Onine &V Go Offine | @, zoomIn @, Zoom Out

)_\
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Siemens LOGO varmuuskopion ottaminen logiikalta

Taman jalkeen PG/PC:n pitdisi yhdistya logiikkaan.

i oot comion = e R - w—
[Fie B Format W Town Wninw five
EERTRT WS T ALY NN ¥

Dagram Mode M mwork Projec

Jos yhdistaminen onnistui siirry seuraavaan vaiheeseen.

2. Mene Tools => Transfer => LOGO!-> PC

(Fie Edt Formwt View [Tol| Window Hel
ey HE e *‘;;m
ﬁ = : S PE
=TI i B ssoee
; -l
Syschienine cioct with Bl
Shaw Fil venian
Clenr User Progras esd Passmars
Uplaad Dista Log.

i3

Comtigers Metwork Ardress

o gare MasterSianee Mads
STl

Summer bemeNilar S

541 LOGEP T Pamrdr-o4 Seren
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Siemens LOGO varmuuskopion ottaminen logiikalta

Taman jalkeen ohjelma ilmoittaa, jos laite on RUN-tilassa. Paina Yes pysayttadksesi logiikan ja aloittaaksesi
varmuuskopion lataamisen logiikalta.

Taman jalkeen ohjelma kopioituu PC:lle. HUOM! kopio ei sisalla kommentteja eika symboleita.
Varmistan taman jalkeen, etta logiikka menee RUN-tilaan. Jos ei niin, niin paina "Start LOGO!".

Lopuksi tallenna kopio File => Save As...

LGOSt E oot
Edil Fomal View Teols Windre Hep

_'\f Hews
¥ open. Lk
g Ciae CirkFe
Cioma &1
B e CrkS
BEVE AN
Page Setup
Prisk Prevview CirkghifteFi
.. Frisi. CirP
esaapes Taat Satings. .
Prepariia. . Ap-Ertar

1 £ 3T 511 500 LN IR N

Exil AkFY

Sivu 3(3)
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Siemens LOGO tyolevyn varmuuskopion palauttaminen logiikalle

LOGON kanssa kaytetaan LOGO! Soft Comfort-ohjelmaa. Jos laitteelle ei ole tyolevysta kopiota, niin silloin
voidaan myos ladata AG-kopio CPU:lle taman ohjeen mukaan.

LOGO versio 7 ja 8:ssa liityntdan kaytetaan Ethernet-kaapelia ja aiempien versioiden kanssa kaytetaan
LOGO! PC-kaapelia.

Ensimmaiseksi kytkeydy kaapelilla kiinni logiikkaan. Taman jalkeen:

1. Avaa Tyolevysta otettu varmuuskopio tai jos sita ei ole, niin CPU:sta aiemmin otettu varmuuskopio.

2. Mene Tools => Transfer => PC -> LOGO!

3. Taman jalkeen aukeaa Interface-ikkuna. lkkunasta paina Test, jolloin ohjelma varmistaa PC:n ja
logiikan valisen yhteyden. Jos yhteydenluonti onnistuu paina OK. Jos ei, niin tarkista yhteysasetukset.

& e =i
rierinee
e g ETGTEL | w08 D e A RS 5L T
Tanges
! Tl | .
Targel I sddiwaa Agciman ook

Sivu 1(2)
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Siemens LOGO tyolevyn varmuuskopion palauttaminen logiikalle

Jos logiikka on RUN-tilassa, ohjelma kysyy, pysaytetaanko CPU. Paina tahan Yes.

The dewice i in RUN mode.

Change to STOP?

Wes I[Hu

(S

Taman jalkeen ohjelma aloittaa latauksen logiikalle. Latauksen jalkeen ohjelma ilmoittaa, etta CPU on
STOP-tilassa. Laita CPU RUN-tilaan painamalla Yes.

Taman jalkeen olet ladannut varmuuskopion ohjelmointilaitteelta logiikalle ja laittanut logiikan takaisin
RUN-tilaan.



